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Part A: Employability Skills 
 

 
Key Points 

 
 Three basic methods are used in the process of communication—Verbal Communication, Non-Verbal Communication, 

and Visual Communication. 

  Verbal communication refers to using words to exchange thoughts, feelings, and ideas with others. 

  There are two primary mediums of verbal communication—Oral communication and Written communication. 

 Verbal communication is further classified into two types—Intrapersonal communication and Interpersonal 

communication. 

  Some of the factors that enhance oral communication are speech, vocabulary, rhythm, tone, and pitch. 

  Written communication means communicating through written words. 

 Verbal communication helps us to think, maintain relationships, define reality, and organise complex ideas and 

experiences into meaningful categories. 

  Non-verbal communication happens in the absence of any oral or composed words. 

 Non-verbal communication depends on different non-verbal prompts like body movements, gestures, facial 

expressions, symbols, images, signals charts, and so on to express sentiments, attitudes, or information. 

 We use non-verbal communication to emphasise, replace, or complement verbal communication, communicate 

emotions, and to give feedback to the other person. 

 The conveyance of ideas and information in forms that can be seen through the eye is referred to as visual 

communication. 

  Verbal communication can be made effective using visual aids. 

 Communication is the process of sharing information between two or more people through an exchange of thoughts, 

messages, and information, using the medium of speech, visuals, symbols, writing, or behaviour. 

  Communication cycle describes how an idea, impression, or feeling is made known to others. 

  Feedback is the response that a receiver gives after the message is received and understood by him. 

  Based on the feedback from the receiver, the sender can evaluate the effectiveness of the message. 

 Feedback is required to continue the process of active communication. It can be effective only when it is heard, 

interpreted, and accepted. 

 Descriptive feedback includes specific information in the form of written comments or verbal conversations that help 

the learner understand what he needs to do in order to improve. 

 Feedback must be task-oriented and allows the students to refine their skills, re-engage in their learning, and 

concentrate on their goal. 

 Specific feedback provides detailed information about something particular, relating to a task or the individual’s 

performance. 

  Non-specific feedback gives a vague response to the receiver. 

 A communication barrier is an obstacle that prevents the receiver from receiving and understanding the message that 

has been sent by the sender. 

  If a message is not understood clearly, it may lead to communication gaps, causing confusion and misunderstanding. 

 Barriers related to the message that is being communicated occur due to problems in the composition or formation of 

the message itself. 

 The factors that cause barriers related to the message being conveyed include lengthy messages, language problems, 

intonation issues, or the non-verbal communication used. 



  

  Internal barriers occur due to some inherent traits or the frame of mind of the communicators. 

 Factors responsible for internal barriers include intense emotions, poor listening skills, prejudice, different viewpoints, 

or different cultural backgrounds. 

  External barriers occur due to factors we have no control over and are outside our body and mind. 

 Factors like noise, different time zones and distance, faulty communication equipment or technologies, physical 

disabilities, and physical barriers preventing us from observing non-verbal communication are some of the causes of 

external barriers. 

 Effective communication implies that the transmitted content has been received and understood by the receiver in a 

manner that was intended by the sender. 

 Effective communication also means that what you want to say, what you say, and what the receiver interprets is 

consistent. 

 Establishing trust and understanding, changing behaviour, and acquiring information are the goals of effective 

communication. 

  The three important points to be considered in communication are content, process, and context. 

 The principles of communication are based on the 7 C’s—Clear, Concise, Concrete, Correct, Coherent, Complete, and 

Courteous. 

  Effective communication reduces misunderstandings and prevents us from overlooking important information. 

  It allows the people involved to build trust and remove any negative emotions. 

  Effective communication skills increase our self-confidence. 

 The most significant benefit of using effective communication techniques is that it improves our relationship with 

others. 

  Stress can be defined as a reaction to any external stimuli that triggers changes in one’s personality. 

  Stress causing agents are known as stressors, which can be self-induced or external. 

 Stressors are factors that have an adverse effect on the physical, emotional, behavioural, and mental health of a 

human being. 

  Stress does not always have a negative impact on us. It can sometimes be useful, helping us to accomplish great things. 

This is known as 'eustress'. 

  Eustress provides us with energy and motivation to achieve our goals. 

 Stress management includes a pool of techniques that assist individuals in eradicating anxiety and negative thoughts, 

and work on their well-being. 

  Stressors can be categorised as positive, dangerous, and irrelevant stressors. 

 Our body is equipped with a natural 'fight or flight' response, in which it reacts spontaneously to protect itself from 

any unfavorable situation. 

  Exercise helps to release endomorphins (chemicals in the brain that act as natural painkillers), and eradicate insomnia. 

  Yoga helps in relieving stress and uplifting our mood. 

  Regular practice of meditation reduces stress, anxiety, and depression. 

  Vacation with friends and family can be a refreshing experience which can help in relieving stress. 

  Nature walk also acts as a stress reliever. 

  Being independent teaches you how to be self-regulated and self-motivated. 

 Independent people are likely to be more confident on handling problems affecting their lives, tend to rely less on 

others, easily make decisions, and are emotionally independent. 

 In order to work independently, a person must possess certain skills—self-motivation, organisational skill, multitasking 

ability, discipline, communication skill, and resourcefulness. 

  The keys to becoming self-reliant are self-awareness, self-motivation, and self-regulation. 



 

 Self-awareness means being aware of your personality, including your strengths, weaknesses, thoughts, beliefs, 

emotions, and motivations. 

  There are two types of awareness—External self-awareness and Internal self-awareness. 

  External self-awareness requires understanding how other people perceive us. 

 Internal self-awareness represents how clearly we see our own values, passions, aspirations, thoughts, feelings, 

behaviours, strengths, weaknesses, and their impact on others. 

  Self-motivation drives a person to attempt and accomplish tasks. 

  There are two main types of motivation–intrinsic and extrinsic. 

 Intrinsic motivation refers to the behavior of a person that is driven by his innate desire to do something for his own 

sake and personal rewards. 

 Extrinsic motivation refers to the behaviour of a person that is driven by the desire to attain some sort of an external 

reward, including money, power, and good grades. 

  Self-regulation involves being able to control reactions to emotions like frustration or excitement. 

 The fundamentals of being independent are the ability to work on your own, with minimal direction, confidence, self- 

awareness, self-motivation, and self-regulation. 

  An operating system is the first program that gets loaded into a computer memory. 

  An operating system acts as an interface between hardware and software. 

  GUI is more user-friendly as it lets the user to interact with the computer by using visual tools. 

  Desktop is the first screen that is displayed after switching on Windows. 

  A file system defines the ways in which files are named and placed for storage and retrieval. 

  In a hierarchical file system, the files are organised into folders and sub-folders in a tree-like structure. 

  A computer virus is a program or set of programs that disrupts the normal operation of a computer. 

  VIRUS stands for Vital Information Resources Under Seize. 

 Antivirus software are computer programs, which are designed to identify, prevent, and remove viruses from a 

computer. 

  Proper working of the hardware components of a computer can be ensured by physically cleaning them, keeping them 

in a proper manner, and repairing them whenever required. 

 Cleaning of the software installed on the computer involves the scheduled disk cleanup tasks, protection against 

viruses, deleting the temporary and unwanted files, etc. 

 An entrepreneur is a person who establishes a business or a venture that generates some value to the customer and 

proves to be profitable for him. 

  Entrepreneurship can be described as starting a business by using the resources available to a person. 

  Entrepreneurship has a crucial role in the functioning of the society. 

  A business venture needs to have a novel element or process to make it acceptable and thriving in the market. 

 New and improved products, services, and technology from entrepreneurs enable to develop new markets and create 

new wealth. 

  The job creation by new and existing businesses is one of the primary goals of economic development. 

  Entrepreneurs play a key role in increasing the standard of living in a community. 

  Entrepreneurs are often seen as visionaries and risk-takers who take well-calculated risks. 

  The two important personality traits that entrepreneurs possess are perception and intuition. 

  Developed countries are moving from 'managerial' to 'entrepreneurial' economies. 

 Being an entrepreneur teaches life skills, increases creativity and problem solving skills, provides a better understanding 

of business and market economics, improves, communication, teamwork, and networking skills, and hence, enhances 

employability. 



  

 
 

A. Multiple Choice Questions. 

1. Keyboard is a/an ................................ device. 

a. Output b. Input 

c. Both (a) & (b) d. None of these 

2. What is the full form of FTP? 

a. File Transfer Protocol b. File Typical Protocol 

c. Frequent Transfer Protocol d. First Time Protocol 

3. Which of the following two are the parts of CPU? 

a. Control Unit b. Control Unit and ALU 

c. Printer and Main Memory d. ALU and Input Device 

4. BCC option is used to send a copy of e-mail to ...................................... . 

a. A blind person 

b. Several people without letting them know sender's address 

c. Several people without letting the other recipients know 

d. All of these 

5. Different type of indentations are ...................................... . 

a. Left and Right b. First Line and Right 

c. Left and First Line d. Left, First Line and Right 

6. To move a file/ folder from one location to another, use ................................ options. 

a. Copy and Paste b. Cut and Paste 

c. Move and Paste d. Delete and Paste 

7. Two popular pointing devices are ...................................... . 

a. MICR and OCR b. Light Pen and Keyboard 

c. Mouse and Joystick d. Mouse and Digital Camera 

 Sustainable development is development that meets the needs of the present without compromising the ability of 

future generations to meet their own needs. 

 Conventionally, the environment was considered a separate entity, detached from human emotion or action; whereas 

development was a term used to describe political goals and economic progress. 

 The concept of sustainable development is that the environment is where we live and development is what we all do 

to improve our lives. 

 The objectives of sustainable development are economic growth, environmental protection, social inclusion, and 

cultural diversity. 

 The objectives to achieve effective and sustainable development must be applied simultaneously, interacting with one 

another in a consistent and committed effort. 

 The principles of sustainable development are based on the integration of environmental, social, and economic 

concerns into all aspects of decision making. 

 Sustainable Development Goals (SDGs) are the collection of 17 global goals set by the United Nations General Assembly 

in 2015 for the year 2030. These were implemented from 1st January, 2016. 

 The major challenges of sustainable growth are eradicating extreme poverty, promoting sustainable consumption and 

production, and managing the planet's natural resource base. 



 

8. One of the major consequences of high self-esteem is ...................................... . 

a. Increased worker involvement in teams b. Decreased complaints from unionized workers 

c. Good mental health d. Increased absenteeism 

9. In oral communication the speaker can observe the listener's being elated. 

a. Response b. Rejection 

c. Reaction d. Reset 

10. WWW stands for ...................................... . 

a. World Wide Web b. Word Wide Web 

c. World Word Web d. Word World Web 

11. Most of our day-to-day reading is done ...................................... . 

a. Loudly b. Intensively 

c. Silently d. Extensively 

12. The elements of communication is ...................................... . 

a. Clarity b. Anxiety 

c. Information Overload d. Feedback 

13. Kinesthetic is the interpretation of body language, such as ...................................... . 

a. Facial expressions b. Gestures 

c. Non-verbal behaviour related to movement d. All of these 

14. MICR is mostly used ...................................... . 

a. Bank b. Railway 

c. To check examination copy d. All of these 

15. Types of skill development includes ...................................... . 

a. Speaking b. Listening 

c. Negotiating d. All of these 

16. Binary code is also known as ...................................... . 

a. Assembly language b. High level language 

c. Procedural language d. Machine language 

17. What is the full form of PPP? 

a. Point-by-point Protocol b. Point-in-point Protocol 

c. Point-to-point Protocol d. None 

18. What is essential to understand pronunciation of simple words? 

a. Role of Vowels b. Role of consonants 

c. Both (a) and (b) d. None of these 

19. Email servers accept, forward, deliver and ................................ messages. 

a. Store b. Delete 

c. Change d. None of these 

20. She was so shy ................................ all invitations. 

a. That to refuse b. As to refuse 

c. As refusing d. For refusing 



  

21. A ................................is a word which connects words phrases, clauses or sentences. 

a. Preposition b. Interjection 

c. Conjunction d. Verb 

22. In an interview when you do not know an answer, you should ...................................... . 

a. Admit you do not know the answer b. Remain quiet 

c. Keep guessing d. Bluff 

23. Microsoft window is a/an ...................................... . 

a. Operating system b. Word processing 

c. Graphic program d. Data base program 

24. Ctrl + V is used to ...................................... . 

a. Copy the selected text b. Paste the selected text 

c. Cut the selected text d. Print the selected text 

25. Which of the following cell pointer indicates you that you can make selection? 

a. Doctor's symbol (Big Plus) b. Small thin plus icon 

c. Mouse pointer with anchor at the tip d. None of these 

26. Which of the following is NOT good practice when in an interview? 

a. Sit upright in your chair b. Speak in varied tones 

c. Cross your arms d. Smile 

27. Which of the following input device is used in playing computer games? 

a. Scanner b. Joy stick 

c. Light pen d. Digital camera 

28. External memory or is a form of permanent storage. 

a. Secondary memory b. Internal memory 

c. Primary memory d. Random Access memory 

29. GUI stands for ...................................... . 

a. Group User Interface b. Graphical Utility Interface 

c. Graphical User Interface d. Guided User Interface 

30. We should ................................ during communication. 

a. Not listen the speaker, carefully b. Interface to the speaker 

c. Listen to the speaker, carefully d. All of these 

31. .............................. stress makes a person worrisome, less productive and may lead to various disorders. 

a. Negative b. Positive 

c. Both a and b d. None of these 

32. Stress refers to ................................ strain/tension. 

a. Physical b. Mental 

c. Emotional d. All of these 

33. Issues related to health of an individual can lead to low self-esteem and cause ................................. stress. 

a. Financial b. Emotional 

c. Mental d. Physical 



 

34. Stress management prevents ...................................... . 

a. Psychological disorders b. Behavioural problems 

c. Both a and b d. None of these 

35. Irritation, impatience, loneliness, upset mood, anxiety are signs of ................................ stress. 

a. Mental b. Physical 

c. Emotional d. None of these 

36. .............................. is/are stress management technique. 

a. Physical Exercise b. Yoga 

c. Meditation d. All of these 

37. .............................. is a practice where an individual is supposed to focus his/her mind. 

a. Yoga b. Physical Exercise 

c. Meditation d. Nature Walk 

38. Self-Reliance means ...................................... . 

a. Ability to Work Independently. 

b. Take ownership of the task assigned and leave no stone unturned in accomplishing the task. 

c. Both a and b 

d. None of these 

39. Having conscious knowledge of your own self, capabilities, feelings and one's own character is called as ................................... . 

a. Self-Regulation b. Self-Motivation 

c. Self-Awareness d. None of these 

40. Ability to work independently can be enhanced by being ...................................... . 

a. Self-aware b. Self-motivated 

c. Self-regulated d. All of these 

41. Being ................................ means that you can identify your strengths and weaknesses. 

a. Self-confidence b. Self-motivated 

c. Self-regulated d. None of these 

42. .............................. makes you to complete work or studies without others cheering you. 

a. Self-confidence b. Communication 

c. Self-motivation d. Self-esteem 

43. Ravi works hard to get the best student award at the end of year. What type of motivation is this? 

a. Internal b. External 

c. Intermediate d. None of these 

44. Neha spends all her after-school hours to practice more and more sample question papers. She wants to do well in her 

exams. This is an example of ...................................... . 

a. Self-Awareness b. Self-Motivation 

c. Self-Regulation d. None of these 

45. .............................. are a set of dreams with a deadline to get them. 

a. Goals b. Goal Setting 

c. Vision d. None of these 



  

1. b 
11. c 
21. c 
31. a 
41. a 

2. a 
12. d 
22. b 
32. d 
42. c 

3. b 
13. d 
23. a 
33. d 
43. b 

4. c 
14. a 
24. b 
34. c 
44. b 

ANSWERS 

5. d 6. b 
15. d 16. d 
25. a 26. c 
35. a 36. d 
45. a 46. a 

7. c 
17. c 
27. b 
37. c 
47. d 

8. c 
18. c 
28. a 
38. c 
48. a 

9. c 
19. a 
29. c 
39. c 
49. d 

10. a 
20. b 
30. c 
40. d 
50. d 

46. We can use ................................ method to set goals. 

a. Smart b. Class 

c. First d. None of these 

47. Goals should be ...................................... . 

a. Specific b. Measurable 

c. Achievable d. All of these 

48. Which of the following is an un realistic goal? 

a. I will read my entire year’s syllabus of all subjects in one day. 

b. I will write 1 page daily to improve my hand writing. 

c. Both a and b 

d. None of these 

49. Qualities of self-motivated people is/are ...................................... . 

a. They are focused b. They know what is important 

c. They are dedicated to fulfil their dreams d. All of these 

50. Time management is the thinking skill that helps you to ...................................... . 

a. Complete tasks on time b. Make a daily timetable. 

c. Not waste time during the day. d. All of these 
 



 

Part–B: Subject Specific Skills 

Unit–I: Digital Documentation (Advanced) 

 
Key Points 

 
 A style is a predefined combination of various formatting features, like font style, colour, and size that is applied to the 

selected text in a document to quickly change its appearance. 

 There are five categories of styles available in Word — Paragraph, Character, Linked (paragraph and characters), Table, 

and List. 

  You can apply built-in styles from the Styles group of the Home tab. 

  In a Word document, you can insert an image from a file, scanned image, or Clip Art. 

  Clip Art is a collection of pictures or images that are available in Microsoft Office gallery. 

 You can modify the images using options available in the Format tab that appears under the Picture Tools contextual 

menu. 

  You can resize an image by dragging any corner or side handles. 

  Shapes is a drawing feature that helps you to draw different object, like stars, banners, callouts, connectors, etc. 

  It is often convenient to group shapes together so that they can be treated as a single object. 

  Wrapping text means surrounding an image or a drawing object within the text. 

  You can align drawing images and objects horizontally and vertically in a document. 

 A template is a predefined layout that contains sample content, themes, colours, font styles, background styles, etc., 

and gives an initial foundation to create a document. 

  A template can be created in Word by saving a document as a .dotx or .dot file. 

  When you create a new document in Word, a default template Normal.dotm is always associated with it. 

 The Table of Contents (TOC) consists of headings and sub-headings of a book or document. It is a necessary index, 

generally available in long documents, books, drafts, etc. 

  To create table of contents, you must use appropriate styles for the headings in your document. 

 You can create a table of contents by clicking on the References tab > Table of Contents option from the Table of 

Contents group. 

 Mail Merge involves three basic steps — creating a main document, specifying a data source, and merging the data 

source with the main document. 

  Mail Merge feature can also help you in printing multiple address labels on a single sheet. 
 

 

A. Multiple Choice Questions. 

1. Advantages of Mail Merge is ...................................... . 

a. Time Consuming b. Write letter multiple times 

c. Difficult to implement d. None of these 

2. List that contains name, addresses etc which changes in every document is called ...................................... . 

a. Data Source b. Main Document 

c. Main List d. None of these 

3. Document (in mail merge) which contain the common data is called ...................................... . 

a. Data Source b. Common Document 

c. Main Document d. None of these 



  

4. Writer prompt you to confirm delete while deleting table of content. 

a. True b. False 

5. Mail Merge involves merging of 

a. Two documents b. Two mails 

c. Both a and b d. None of these 

6. Which tab of Insert Index/Table dialog box help us to apply paragraph style to the table of content. 

a. Paragraph Style b. Styles 

c. Columns d. Background 

7. The E# button in Entries tab of Insert Index / Table represent. 

a. Entry Text b. Chapter Number 

c. Tab Stop d. Page Number 

8. We cannot change the table of content directly in the document if: 

a. “Protected against manual changes” check box is selected 

b. Number of level is 3 

c. Title is entered in the Title field 

d. None of these 

9. We cannot create our own template. 

a. True b. False 

10. We can create template .for ...................................... . 

a. Letter b. Fax 

c. Presentation d. All of these 

11. A template can have: 

a. Text b. Graphic 

c. Particular Style d. All of these 

12. Reena wants that her company’s logo should automatically appear on the top of the document whenever she opens a new 

document. Which feature will help her to do so? 

a. Style b. Automatic 

c. Template d. All of these 

13. Four resizing handles (other than the corner handles) resize image only in one dimension. 

a. True b. False 

14. .............................. refers to the reference point for the graphics. 

a. Anchoring b. Text Wrapping 

c. Text Reference d. All of these 

15. .............................. refers to the relation of graphics to the surrounding text. 

a. Anchoring b. Text Wrapping 

c. Graphic Wrapping d. All of these 

16. Which of the following setting is not used for positioning of graphic? 

a. Arrange b. Alignment 

c. Wrap d. Caption 

17. Once we group two or more objects in a document, we cannot ungroup them. 

a. True b. False 



 

1. d 
11. d 
21. b 

2. a 
12. c 
22. a 

3. c 
13. a 
23. b 

4. a 
14. a 
24. a 

ANSWERS 

5. a 6. b 
15. b 16. d 
25. d 26. d 

7. b 
17. b 
27. a 

8. a 
18. d 
28. b 

9. b 
19. d 
29. b 

10. d 
20. c 
30. a 

18. When we right click on drawing object, a ................................ menu open. 

a. Pop up Menu b. Shortcut Menu 

c. Context Menu d. All of these 

19. To select two drawing objects in a document, select one object and hold ............................... key and select the other object. 

a. Ctrl b. Alt 

c. Spacebar d. Shift 

20. To retain original proportion of the graphic, ................................. + click one of the corner handles. 

a. Ctrl b. Alt 

c. Shift d. None of these 

21. In which of the following, size of image does not change even after cropping of image? 

a. Keep Scale b. Keep image size 

c. Both of the above d. None of these. 

22. Which option help us to take only particular section/part of image? 

a. Crop b. Background 

c. Wrap d. None of these 

23. We cannot give border to picture. 

a. True b. False 

24. Transparency effect help to create watermark. 

a. True b. False 

25. Color toolbar allow us to change 

a. RGB Color Components b. Brightness 

c. Gamma Effect of Image d. All of these 

26. Flip Vertically option in picture toolbar will make the image as the ...................................... . 

a. mirror placed at the left of the image b. mirror placed at the right of the image 

c. mirror placed at the top of the image d. mirror placed at the bottom of the image 

27. Area where cut and copied image stored is ...................................... . 

a. Clipboard b. RAM 

c. ROM d. Imageboard 

28. We cannot copy the styles from another document. 

a. True b. False 

29. Which of the style include header and footers, border, margins? 

a. Character Style b. Page Style 

c. Frame style d. Presentation Style 

30. A ................................is a set of formats that you can apply to selected pages, text, frames. 

a. Style b. Template 

c. Image d. Graphics 
 



  

Part–B: Subject Specific Skills 

Unit–II: Electronic Spreadsheet (Advanced) 

 
Key Points 

 
 The Consolidate feature collates the contents of the cells from several worksheets and maintains the collected data in 

a master worksheet with minimal efforts. 

  The Subtotal feature generates a subtotal of the rows of related data. 

 By using the Scenarios feature, you can create as many scenarios as you want and then compare them without 

changing the values, manually. 

 The Data Table tool displays the result of applying formula to a list of alternative values for variables in a separate 

range of cells. 

 Goal Seek is used to set a goal to find the optimum value for one or more target variables, given with the certain 

conditions. 

  Solver is the elaborate form of Goal Seek. It deals with equations with multiple unknown variables. 

 Linking spreadsheet data enables you to keep the information updated without editing multiple locations every time 

the data changes. 

  Sharing a spreadsheet means giving access to the other users to work on the same spreadsheet at the same time. 

  The Track Changes feature enables you to keep a track of the changes done by you or the other users in a spreadsheet. 

  Hyperlink is a coloured and underlined text or graphic that you click to open a file, location in a file, or a web page. 

  There are two types of hyperlinks — Relative and Absolute. 

  A relative hyperlink contains a partial address, i.e., an address that is relative to the address of the output file. 

  An absolute hyperlink contains the full address of the destination file or web page. 

  The Macros feature of Excel allows you to record a set of actions that you perform repeatedly in a spreadsheet. 

 

A. Multiple Choice Questions. 

1. ................................... allows you to gather data from different worksheets into a master worksheet. 

a. Data Consolidation b. Goal Seek 

c. Solver d. Total data 

2. Consolidate option is available under ................................ menu. 

a. View b. Tool 

c. Insert d. Data 

3. We can consolidate data by ...................................... . 

a. Row Label b. Column Label 

c. Both a and b d. None of these 

4. In which option do we have to specify the target range? 

a. Source data range b. Copy results to 

c. Need result at d. target range 

5. Which option is used to name a range of cells? 

a. Range name b. Cell Range 

c. Define Range d. Select Range 



 

6. Define range option is available under ................................ menu. 

a. Insert b. View 

c. Developer d. Data 

7. The text in the row label or column label must be identical, otherwise, new row or column will be inserted. 

a. True b. False 

8. SUBTOTALS ............................... data arranged in a group of cells. 

a. Add b. Average 

c. Find d. Clear 

9. In Subtotals we can select up to ................................ groups of arrays. 

a. 2 b. 3 

c. 4 d. Infinite 

10. Scenarios are tools to test ................................ questions. 

a. if else b. what else 

c. what if d. if 

11. Scenario option is available in ................................ menu. 

a. Data b. Tools 

c. Insert d. Windows 

12. We can shift from one scenario to another by ...................................... . 

a. Navigator b. Find and Replace 

c. Data Source d. None of these 

13. We can create only 3 scenarios for a given range of cells. 

a. True b. False 

14. Which option is suitable to calculate the effect of different interest rates on an investment? 

a. Scenario b. Subtotal 

c. Consolidate d. None of these 

15. Goal Seek Option available in ................................ menu. 

a. Data b. Format 

c. Tools d. Insert 

16. We can give different colours to different scenarios? 

a. True b. False 

17. ................................. is more elaborate form of Goal Seek. 

a. Scenario b. Subtotal 

c. Solver d. All of these 

18. When you open a new spreadsheet, by default it has sheet named ...................................... . 

a. Sheet1 b. Sheet_1 

c. Sheet 1 d. None of these 

19. Formula to refer a cell A3 in sheet named S1 is: 

a. =S1A3 b. =S1.A3 

c. ='S1'.A3 d. None of these 



  

20. A ................................link will stop working only if the start and target locations change relative to each other. 

a. Relative b. Absolute 

c. Both a and b d. None of these 

21. Hyperlink icon is present on ...................................... . 

a. Format Toolbar b. Standard Toolbar 

c. Menu Bar d. None of these 

22. Raman and his friends wants to work together on a spreadsheet. They can do so by 

a. Sharing Workbook b. Linking Workbook 

c. Both a and b d. None of these 

23. After sharing a worksheet, ................................ is seen in the title bar after the worksheet’s title. 

a. Sharing b. Shared 

c. Sharing Sheet d. None of these 

24. Share document option is available in ................................ menu. 

a. Tools b. View 

c. Edit d. File 

25. Which of the following buttons are present on "Resolve Conflict" dialog box which appear during saving shared worksheet. 

a. Keep Mine b. Keep Other 

c. Keep All Mine d. All of these 

26. A ................................coloured border, appears around a cell where changes were made in shared worksheet. 

a. Blue b. Yellow 

c. Green d. Red 

27. A deleted column or row in shared worksheet is marked by a ................................. coloured bar. 

a. Light b. Line 

c. Solid d. Heavy 

28. Seema is the author of shared worksheet so she has the right to accept or reject changes made by the reviewers. 

a. True b. False 

29. Worksheets can be merged from ................................ menu. 

a. Edit b. File 

c. View d. Tools 

30. Edited worksheet can be compared with the original worksheet by selecting. 

a. File → Compare Document b. Edit → Compare Document 

c. View → Compare Document d. Tools → Compare Document 

31. Macros are especially useful to ................................ a task. 

a. do b. repeat 

c. simplify d. complicate 

32. When a document is created and saved, it automatically contains a library named ...................................... 

a. Module Library b. Macro Library 

c. Standard d. None of these 



 

1. a 
11. b 
21. b 
31. b 

2. d 
12. a 
22. a 
32. c 

3. c 
13. b 
23. b 
33. b 

4. b 
14. a 
24. a 
34. a 

5. c 
15. c 
25. d 
35. c 

ANSWERS 

6. d 
16. a 
26. d 

7. a 
17. c 
27. d 

8. a 
18. a 
28. a 

9. b 
19. c 
29. a 

10. c 
20. a 
30. b 

33. Function names in Calc are not case sensitive. 

a. True b. False 

34. Use ................................ Macro to start the macro recorder. 

a. Tools > Macros > Record b. Tools > Record > Record Macro 

c. Data > Macros > Record d. None of these 

35. Click ................................ to stop the macro recorder. 

a. Close Recording b. End Recording 

c. Stop Recording d. None of these 
 



  

Part–B: Subject Specific Skills 

Unit–III: Database Management System 

 
Key Points 

 
  Data is a raw and unprocessed form of facts and figures. 

  Information is a processed and meaningful data that can be easily interpreted. 

  Database is a collection of data, which is stored in a systematic manner, i.e., in the form of tables. 

  A table holds information in the form of rows and columns. 

  In a database table, rows are referred to as records or tuples and columns as fields or attributes. 

  A record is set of related information that belongs to a particular instance of an object. 

  A field describes a specific property of a record. It is also known as an attribute. 

 A Database Management System (DBMS) is a computerised record keeping system or a software that enables you to 

create, store, modify, and extract information from a database. 

 A Relational Database Management System (RDBMS) is a type of DBMS software that uses relational database (RDB) 

model for its database. 

  A relational model enables the users to store data in several tables. 

 A primary key is a set of one or more fields that uniquely identify each record in a table. It does not contain any 

duplicate data or NULL value. A table can have only one primary key. 

 A composite key or composite primary key refers to a combination of two or more attributes (fields) that uniquely 

identify the records in a table. It may be a candidate or primary key. 

 A foreign key consists of one or more fields whose value matches a primary key in another table. It acts as a cross- 

reference between the tables. 

 There are four main objects in any database - Tables, Queries, Forms, and Reports. A data type determines what type 

of data you can enter into a field. 

 Referential Integrity (RI) is a rule in RDBMS. It states that a foreign key must have a matching primary key, i.e., all its 

references must be valid and the users cannot accidentally delete or amend data. 

 The three different types of relationships that can exist between a given pair of tables are: One-to-One, One-to-Many, 

and Many-to-Many. 

  In a One-to-One relationship, a record in a table can have only one matching record in another table. 

 In a One-to-Many relationship, a record of a table is associated with several matching records in another. However, the 

record of the second table is associated with only one record in the first table. 

  In a Many-to-Many relationship, one record is associated with several records in another table, and vice versa. 

 In RDBMS, a query is a database object that enables you to retrieve records from one or more tables of a database or 

different databases that meet a specific condition or criteria. MS Access provides various built-in functions to perform 

calculations on query data. 

  Structured Query Language (SQL) is the language used in RDBMS for writing queries. 

 Data Definition Language (DDL) commands are used to define and modify the structure of a database. Some commonly 

used DDL commands are Create, Alter, Drop, Truncate, and Rename. 

 Data Manipulation Language (DML) commands help in retrieval, insertion, deletion, and modification of the information 

present in the database. Some commonly used DML commands are Select, Insert, Update, and Delete. 



 

A. Multiple Choice Questions. 

1. A database is an organized collection of ...................................... . 

a. Data b. Attributes 

c. Record d. None of these 

2. Which of the following software is appropriate to store data about school students? 

a. MS Access b. Writer 

c. Calc d. Impress 

3. Which of the following is not a database program? 

a. MySQL b. Oracle 

c. Writer d. OObase 

4. ................................ store data in Single table. 

a. Flat File b. Relational 

c. Single File d. One File 

5. ................................ are dedicated computers that hold the actual databases and run only DBMS and related Software. 

a. Main Server b. Web Server 

c. Database Server d. Non-Database Server 

6. GUI act as front end and database server act as ...................................... 

a. Container b. Back End 

c. End d. None of these 

7. Duplication of data is called ...................................... . 

a. Inconsistency b. Consistency 

c. Redundancy d. Foreign Key 

8. Which of the following is not an advantage of database? 

a. Sharing of Data b. Reduce Data Redundancy 

c. Increase Data Inconsistency d. Data Security 

9. Data Integrity means that data is accurate and consistent in the database. 

a. True b. False 

10. A database can have only one table. 

a. True b. False 

11. Which of the following will help to maintain unique record in the table? 

a. Foreign Key b. Primary Key 

c. Composite Key d. Alternate Key 

12. Which of the following field of table “Book” can act as primary key? 

a. Book_number b. Subject 

c. price d. Author_name 

13. When primary key is made up of two or more columns then it is called ................................. primary key. 

a. Mixed b. Reference 

c. Composite d. Compost 



  

14. Duplicate values can be entered in primary key. 

a. True b. False 

15. A key which is referring to the primary key of another table is called ...................................... 

a. Alternate Key b. Primary Key 

c. First Primary Key d. Foreign Key 

16. A field which is ................................ for each and every record is called Primary key. 

a. Common b. Same 

c. Unique d. None of these 

17. When data is stored, maintained and retrieved from multiple tables then special database software are required called 

...................................... 

a. DBMS b. RDBMS 

c. Special DBMS d. All of these 

18. Identify the Foreign Key from table “Sales” 

Table Client: 

ClientID (primary Key) 

clientname 

clientphone 

Table : Sales 

SalesID (Primary Key) 

ClientID 

Profit 

a. SalesID b. Profit 

c. Clientphone d. ClientID 

19. Which of the following is not valid field in table “Student”? 

a. admno b. name 

c. fees d. salary 

20. There can be multiple primary keys in a table. 

a. True b. False 

21. In RDBMS, data is organized in the form of ...................................... 

a. Table b. Record 

c. Field d. None of these 

22. SQL stands for ...................................... 

a. Structured Queue Language b. Structured Query Language 

c. Structured Query Language d. None of these 

23. All the values in ................................ are of same type. 

a. Records b. Table 

c. Database d. Fields 

24. .............................. represent a single data item in a table. 

a. Tuples b. Attributes 

c. Relation d. All of these 



 

25. In tables, data is organized in the form of rows and columns. 

a. True b. False 

26. Every row in a table has the same structure. 

a. True b. False 

27. Open Office base is not an open-source software. 

a. True b. False 

28. .............................. are the basic building blocks of a database. 

a. Tables b. Record 

c. Fields d. All of these 

29. We can create table: 

a. in design view b. use Wizard 

c. Both of the above d. None of these 

30. By default, data type of fields is. 

a. Text [Varchar] b. Text [Char] 

c. Int d. Long 

31. Base automatically adds the column as Primary Key if we don’t add it. 

a. True b. False 

32. By default, the length of Varchar data type is ...................................... 

a. 20 b. 30 

c. 40 d. 50 

33. By default, the name of the table is ...................................... 

a. Tab 1 b. Table 1 

c. First Table d. Untitled 1 

34. .............................. are used to identify which type of data we are going to store in the database. 

a. Datatype b. Record 

c. Table d. Attributes 

35. Which data type will be appropriate to store information as Salary, Fees, Price etc? 

a. Numeric Data type b. Alphanumeric Data types 

c. Binary Data types d. Date Time 

36. Which of the following is not a numeric data type? 

a. Tinyint b. Smallint 

c. Boolean d. Date 

37. Which of the following data types cannot store decimal values? 

a. Decimal b. Real 

c. Numeric d. Boolean 

38. Which of the following will occupy more space in computer memory? 

a. Bigint b. Integer 

c. Smallint d. Boolean 



  

39. .............................. data types are used for storing photos, music files etc 

a. Binary b. Alphanumeric 

c. Numeric d. Special 

40. Char is a ...................................... length data type and varchar is a ................................. length data type. 

a. Fixed, Variable b. Variable, Fixed 

c. Variable, Variable d. Fixed, Fixed 

41. Which field is suitable for storing records of employees? 

a. EmpNo b. Empname 

c. Salary d. All of these 

42. Auto Value is a property of ................................ data type. 

a. Numeric b. Character 

c. Binary d. Date 

43. Which of the following property helps to set the number of characters in Varchar type? 

a. Auto value b. Required 

c. Default Value d. Length 

44. Which property ensures that field cannot be left blank? 

a. Entry required b. Format 

c. Required Entry d. Required 

45. By default, the length of the Integer data type is ...................................... 

a. 10 b. 15 

c. 20 d. 25 

46. Which of the following property to be turned “yes” so that value will be auto incremented? 

a. Default b. Format 

c. Auto value d. Length 

47. Which of the following is not the binary data types? 

a. Longvarbinary b. Varbinary 

c. Binary d. Charbinary 

48. Which of the following is not the date time data types? 

a. Date b. Time 

c. Datestamp d. Timestamp 

49. Which data type is used to store value of fields like “Date of Birth”? 

a. Date Time b. Varchar 

c. Integer d. Other 

50. A record in table is also known as Attribute. 

a. True b. False 

51. We can ................................ data in table. 

a. modify b. insert 

c. delete d. All of these 



 

52. In which view data can be entered in table? 

a. Datasheet view b. Design view 

c. Both of the above d. None of these 

53. In which mode we can change the structure of table? 

a. Datasheet view b. Design view 

c. Structure view d. All of these 

54. After inserting records in table, we can not modify the structure of table. 

a. True b. False 

55. Sorting means to arrange data in ................................ order. 

a. increasing b. decreasing 

c. increasing or decreasing d. None of these 

56. Referential Integrity is used to maintain accuracy and consistency of data in a relationship. 

a. True b. False 

57. In Base data can be linked between two or more tables with the help of ...................................... 

a. primary key b. foreign key 

c. primary and foreign key d. None of these 

58. Relationship can be created between 

a. two tables only b. one table only 

c. two or more tables d. None of these 

59. Relationship between tables can be created from ................................ menu. 

a. View b. Insert 

c. Windows d. Tools 

60. There are ................................ types of relationship which can be created between tables. 

a. three b. two 

c. four d. infinite 

61. Which language help to extract/fetch data from table? 

a. MySQL b. Python 

c. OOBase d. HTML 

62. We can create query (in Open Office Base) in ...................................... . 

a. In design view b. Using wizard 

c. Both of the above d. None of these 

63. Queries are commands that are used to define the structure and modify the data in a table. 

a. True b. False 

64. We cannot delete the data using queries. 

a. True b. False 

65. SQL stands for ...................................... 

a. Structural Query Language b. Structured Query Language 

c. Skeletal Query Language d. None of these 



  

66. .............................. statement is used to retrieve data from table. 

a. Delete b. Update 

c. Print d. Select 

67. .............................. is the most common DML command. 

a. Delete b. Update 

c. Select d. All of these 

68. DML stands for ...................................... 

a. Data Manipulation Language b. Database Manipulation Language 

c. Data Modify Language d. None of these 

69. Which of the following clause return specific rows? 

a. Order By b. Where 

c. Having d. Specific 

70. Which of the following clause return records in ascending order? 

a. Order By b. Where 

c. Order Asc d. Order Inc 

71. Command to display all the data in the table “emp” is. 

a. Select * from emp b. Select * from emp; 

c. Select all from emp d. Select all from emp; 

72. Which command is used to create table? 

a. Select b. Create 

c. Open d. New 

73. Shortcut to execute query in Create Query in SQL View is ...................................... 

a. F7 Key b. F5 Key 

c. F8 Key d. F6 Key 

74. Which command is used to display the salary of all the employees after incrementing by 1000? 

a. Select b. Update 

c. Modify d. Change 

75. Select “salary” from emp; 

a. will display all the records of table emp b. will display only particular columns of table emp; 

c. will display only salary column of table emp; d. None of these 

76. Select “empname”, “salary” * 3 from emp; 

a. will increase the salary three times of all employees in table 

b. display name and three times salary 

c. give error 

d. None of these 

77. To get details about the list of students whose favourite colour is blue. Query for this is: 

a. select all from Stud where fav_Color=’Blue’; b. select name from Stud where fav_Color=’Blue’; 

c. select * from Stud where fav_Color=’Blue’; d. select all from Stud where fav_Color is ’Blue’; 



 

78. select * from Stud order by “Rollno” ASC; 

a. display all the records of table. b. display records in increasing order of roll number. 

c. both of the above d. None of these 

79. Which command is used to modify data in table? 

a. delete b. select 

c. modify d. update 

80. Which command is used to delete data from table? 

a. select b. delete 

c. insert d. remove 

81. Update statement is used to modify data in a table. 

a. True b. False 

82. Command to increase the salary of all employees by 15000. (Table name emp and column name sal) 

a. update emp set sal = sal + 15000; b. update emp set sal = 15000; 

c. update set sal = sal + 15000; d. None of these 

83. By default, data is arranged in ................................ order using order by clause. 

a. Ascending b. Descending 

c. Primary Key d. None of these 

84. Which of the following is DML commands? 

a. Insert b. Update 

c. Delete d. All of these 

85. A ................................provides a systematic way of storing information into the database. 

a. Report b. Query 

c. Form d. None of these 

86. Which of the following act as an interface to view, enter and change data in database? 

a. Report b. Table 

c. Query d. Form 

87. A ................................helps to display the data in a summarized data. 

a. Report b. Form 

c. Query d. None of these 

88. A ................................helps to collect specific information from the pool of data. 

a. Query b. Report 

c. Form d. None of these 

89. Which of the following is to be created first? 

a. Report b. Query 

c. Form d. Table 

90. Which of the following field is invalid for storing information of “Library” Table? 

a. Cost b. Booknumber 

c. Authorname d. Dateofbirth 



  

1. a 
11. b 
21. a 
31. a 
41. d 
51. d 
61. a 
71. a 
81. a 
91. a 

2. a 
12. a 
22. b 
32. d 
42. a 
52. a 
62. c 
72. b 
82. a 
92. b 

3. c 
13. c 
23. d 
33. b 
43. d 
53. b 
63. a 
73. b 
83. a 
93. a 

4. a 
14. b 
24. b 
34. a 
44. a 
54. b 
64. b 
74. a 
84. d 
94. d 

ANSWERS 

5. c 6. b 
15. d 16. c 
25. a 26. a 
35. a 36. d 
45. a 46. c 
55. c 56. a 
65. a 66. d 
75. c 76. b 
85. c 86. d 
95. b 96. b 

7. c 
17. b 
27. b 
37. d 
47. d 
57. c 
67. d 
77. c 
87. a 
97. b 

8. c 
18. d 
28. d 
38. a 
48. c 
58. c 
68. a 
78. b 
88. a 
98. a 

9. a 
19. d 
29. c 
39. a 
49. a 
59. d 
69. b 
79. d 
89. d 
99. a 

10. b 
20. b 
30. a 
40. a 
50. b 
60. a 
70. a 
80. b 
90. d 

100. a 

91. Which of the following is suitable to act as a primary key in table student? 

a. Rollno b. Name 

c. Class d. Section 

92. A foreign key is a reference of the ................................ key in another table. 

a. Alternate b. Primary 

c. Candidate d. None of these 

93. A table is a collection of logically related data. 

a. True b. False 

94. .............................. tables can be created in a database. 

a. 1 b. 2 

c. 3 d. More than 3 

95. In primary key we can enter NULL values. 

a. True b. False 

96. Only numeric fields can act as a primary key in a table. 

a. True b. False 

97. Primary key increases data redundancy. 

a. True b. False 

98. In a table we can have only ................................ primary key. 

a. 1 b. 2 

c. 3 d. More than 3 

99. A foreign key is a primary key in another table. 

a. True b. False 

100. Duplicate values can be entered in Foreign key. 

a. True b. False 
 



 

Part–B: Subject Specific Skills 

Unit–IV: Web Applications and Security 

 
Key Points 

 
 The ‘Accessibility’ options available in Windows have been designed to help the users who have difficulty in using 

computers due to an impairment. 

 Windows provides two features as alternatives for the common input devices, mouse and keyboard. These are Speech 

Recognition and On-Screen Keyboard. 

  Turning on Sticky Keys feature is useful for those who face difficulty in pressing more than one key at a time. 

  Data communication means sending data electronically from one computer to another. 

 A computer network may be defined as a group of two or more computer systems or peripheral devices, that are 

connected together to exchange information and share resources among a wide range of users. 

  A global interconnection of computer networks around the world is known as the internet. 

 Instant Messaging (often called IM) refers to real-time communication with the user at the other end through an 

application called the Instant Messenger. 

  There are two types of Instant Messaging software — application-based and web-based. 

  Application-based IMs are the application programs that can be easily downloaded and installed on the user's devices. 

  Web-based IMs can be accessed using a browser application, such as Google Chrome, Internet Explorer, and so on. 

  Google Hangouts is integrated within Gmail, that is why it can be used from Gmail as well. 

 WhatsApp is the most popular instant messenger, widely used for sending text and voice messages, and making audio 

and video calls. 

 A blog is a combination of the words web and log. It is a frequently updated, online, personal journal or diary where 

a person can log (write or post) information related to his interests or activities, express his ideas or opinions or share 

his knowledge through writing. 

 The person who writes a blog is called a Blogger. He can interact with the readers by answering their questions and 

regularly updating the contents after the readers have given comments related to the page. 

 Word Press is an online website/blog creation tool, which is versatile and simplest to use. It offers both paid and free 

service. 

  Blogs may contain text and pictures but videos and even audios can also be added to give more information. 

 Offline blog editors are the application software that help you to easily write, edit, spell-check, and manage the 

content of your blog without being connected to the Internet. 

  Qumana is one of the best desktop-based blog editors. 

 Buying and selling of goods and services by electronic means, combined with the power of the Internet is known as 

e-commerce. 

  Exchange of information on line is known as Electronic Data Interchange. 

 Phishing is an act of sending an e-mail to a user; misleading him to believe that it is from a trusted person or 

organisation. 

 Email spoofing is one of the most common security threats that involves sending emails to the targeted recipients to 

make them believe that these emails originate from trusted resources. 

 Chat spoofing is quite similar to email spoofing. In chat spoofing, the spoofing happens when the target is engaged in 

a chat process. 

  To keep information safe, we must use strong passwords as combination of alphanumeric and special characters. 

 A firewall is a software that can help in preventing unauthorised access to your computer by blocking unsolicited 

communications. 



  

 

 
A. Multiple Choice Questions. 

1. A computer network allows sharing of resources and information. 

a. True b. False 

2. A computer network is a collection of 2 or................................. computers. 

a. 5 b. 7 

c. 9 d. More 

3. P2P stands for: 

a. Peer to Peer b. Pipe to pipe 

c. Peer 2 Peer d. Pipe 2 Pipe 

4. A computer who makes a request for services in Client Server Architecture is called ...................................... . 

a. Server b. Client 

d. Node d. None of these 

5. A ................................ network is one which connects computers and devices in a limited geographical area such as home, 

school etc. 

a. PAN b. MAN 

c. LAN d. WAN 

6. Internet is an example of: 

a. LAN b. WAN 

c. MAN d. PAN 

7. Computer Accessibility refers to the user friendliness of a computer system. 

a. True b. False 

 Fire is a very serious hazard at a workplace. It can cause major financial losses to a business and also result in a loss of 

human lives. 

 Slips, trips, and falls are common causes of injury at the workplace. They can be prevented with a better understanding 

of their cause and methods to avoid them. 

  Electrically-powered equipment can be a major hazard for workers, particularly when mishandled or not maintained. 

 First aid is emergency care given immediately to an injured person, to minimise injury and future disability and in 

serious cases to keep the affected person alive. 

 An accident at a workplace is an unplanned, unintended, and unexpected incident, which can cause minor to severe 

physical injury or even result in death. 

 A workplace emergency is an unforeseen situation that threatens the employees, customers, or the public. It disrupts 

the company’s operations and causes physical or environmental damage. 

  A hazard is any agent that can cause harm or damage to human life, property, or the environment. 

 A workplace hazard refers to a situation within the workplace that has the potential to cause injury or adverse health 

effects for people and damage to the plant or equipment. 

 The employers must advise their employees on evacuation procedures as a part of their training in order to minimise 

the damage caused due to emergency situations. 

  Encouraging employees to eat healthy and live actively is beneficial to them as well as employers in the long run. 



 

8. A person with disability or impairment cannot use computer. 

a. True b. False 

9. Identify the cognitive impairment from the following. 

a. Dyslexia b. ADHD 

c. Autism d. All of these 

10. Keyboard Accessibility options are useful for those who have: 

a. Physical disabilities b. Vision impairment 

c. Both a and b d. None of these 

11. .............................. keys are used to reduce repetitive strain. 

a. Filter b. Sticky 

c. Toggle d. Control 

12. Which of the following options allows us to press Ctrl key and 'A' key separately? 

a. Filter keys b. Toggle keys 

c. Sticky keys d. Mouse keys 

13. Toggle Keys is designed for people who have ...................................... . 

a. Vision Impairment b. Cognitive Disabilities 

c. Both a and b d. None of these 

14. Effect of toggle keys can be checked by pressing ................................ key. 

a. Num Lock b. Caps Lock 

c. Scroll Lock d. All of these 

15. SoundSentry is designed to help users with ................................ impairments. 

a. Physical b. Auditory 

c. Visual d. None of these 

16. The ................................ is a global system of interconnected computer networks. 

a. Internet b. Intranet 

c. ARPANET d. None of these 

17. A web page may contain A web page can be viewed with the help of ...................................... . 

a. Web Browser b. Web server 

c. Internet d. Protocol 

18. Which of the following is not a web browser? 

a. Mozilla Firefox b. Internet Explorer 

c. Google Chrome d. None of these 

19. .............................. is a computer that stores web sites and their related files for viewing on the Internet. 

a. Web server b. Web Client 

c. WWW d. Web 

20. Dial up connection is the fastest internet connection. 

a. True b. False 



  

21. Which of the following files can be shared over network? 

a. Text b. Sound 

c. Spreadsheet d. All of these 

22. WiMAX is a ................................ technology. 

a. Wired b. Wireless 

c. Internet d. None of these 

23. Which of the following technology is used for long distance? 

a. Dial up b. DSL 

c. Cable Internet Access d. WiMAX 

24. Which of the following technology is used to provide free internet in hotels, malls etc. to their customers? 

a. WiFi b. WiMAX 

c. Dial up d. Cable Internet Access 

25. .............................. converts the analog signals to digital and vice versa. 

a. Switch b. Modem 

c. Router d. None of these 

26. .............................. is a form of communication over internet. 

a. Email b. Video call 

c. Instant messaging d. All of these 

27. .............................. offers instantaneous transmission of text-based messages from sender to receiver. 

a. Email b. Traditional post 

c. Instant messaging d. All of these 

28. For audio and Video chat users should have ...................................... . 

a. Mike b. Speaker 

c. Web Cam d. All of these 

29. Key Features of an instant messaging are: 

a. Text Messages can be sent to one or more person 

b. Audio calling and conferencing 

c. Video calling and conferencing 

d. All of these 

30. For using Google Talk, you should have   account. 

a. Gmail b. Skype 

c. Yahoo d. None of these 

31. Blogs are similar to an online ...................................... . 

a. Book b. Notebook 

c. Journal d. Diary 

32. Websites that offer free blog services are: 

a. www.WordPress.com b. www.blogger.com 

c. www.blogsome.com d. All of these 

http://www.wordpress.com/
http://www.blogger.com/
http://www.blogsome.com/


 

33. We can use blogs to convey messages about ...................................... . 

a. Events b. News 

c. Reviews d. All of these 

34. Blog address should be unique. 

a. True b. False 

35. The title of the blog comes at the ...................................... . 

a. Top b. Bottom 

c. Side d. None of these 

36. Others can view the blog post only after publishing it. 

a. True b. False 

37. Online shopping is an example of ...................................... . 

a. E-learning b. E-commerce 

c. E-reservation d. All of these 

38. Customers can pay online using ...................................... . 

a. Credit card b. Debit card 

c. Internet banking d. All of these 

39. COD (in reference to online shopping) stands for ...................................... . 

a. Catch on delivery b. Cash on delivery 

c. Cash over delivery d. None of these 

40. Which of the following are Online threats? 

a. Phishing b. Email Spoofing 

c. Chat spoofing d. All of these 

41. Online threats can be reduced by using ...................................... . 

a. Firewall b. Passwords 

c. Antivirus d. All of these 

42. Which of the following passwords is not easy to crack? 

a. Name b. Date of birth 

c. Mobile number d. Mix of digits and letters 

43. .............................. could transmit every key pressed on a keyboard to unauthorized users. 

a. Keypress b. Keylogger 

c. Antivirus d. None of these 

44. Cookies are ................................ that are created on your local computer when you visit websites. 

a. Text files b. Folders 

c. Virus d. None of these 

45. Firewalls could be a ...................................... . 

a. Hardware b. Software 

c. Both a and b d. None of these 



  

10. c 
20. b 
30. a 
40. d 
50. d 

9. d 
19. a 
29. d 
39. b 
49. b 

8. b 
18. d 
28. d 
38. d 
48. a 

7. a 
17. a 
27. c 
37. b 
47. a 

6. b 
16. a 
26. d 
36. a 
46. d 

5. c 
15. b 
25. b 
35. a 
45. c 
55. d 

4. b 
14. d 
24. a 
34. a 
44. a 
54. b 

3. a 
13. c 
23. d 
33. d 
43. b 
53. c 

2. d 
12. c 
22. b 
32. d 
42. d 
52. b 

1. a 
11. b 
21. d 
31. d 
41. d 
51. c 

ANSWERS 

46. Basic safety rules to follow at workplace includes: 

a. Fire safety b. Falls and slips 

c. Electrical safety d. All of these 

47. Keep workplace a no-smoking zone is a basic rule of: 

a. Fire Safety b. Falls and Slips 

c. Electrical Safety d. First Aid 

48. Which of the following are some of the measures to keep ourselves safe from electricity hazards and accidents? 

a. Electrical equipment used should be of sub-standard quality 

b. Workers should be trained to handle the electric equipment safely 

c. Circuits should not be overloaded 

d. Insulated tools and handling equipment must be used 

49. Learning ................................ is the social and civic responsibility of every human being. 

a. Computers b. First-aid 

c. Handling electrical equipment d. None of these 

50. Types of Occupational Hazards are: 

a. Physical hazards b. Biological hazards 

c. Ergonomic hazards d. All of these 

51. Unfortunate incident that occurs unintentionally causing hazardous result or injury is called: 

a. Emergency b. Hazard 

c. Accident d. None of these 

52. Any unexpected situation that needs immediate attention and action is called: 

a. Accident b. Emergency 

c. Occupational Hazard d. None of these 

53. Source of any potential harm is called: 

a. Emergency b. Accident 

c. Hazard d. All of these 

54. .............................. is the process of clearing a place in case of an emergency. 

a. Buddy System b. Evacuation 

c. Clearing d. Vacating 

55. Healthy life style includes: 

a. Healthy eating habits b. Sound sleep 

c. Physical activities d. All of these 
 


